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 Design and Implementation  
of Automated Atlas 

1.1. From map to atlas 

Given the multiplication of spatial data, automated workflows are becoming 
important in GIS environments (graphical modeler, programming). Beyond data 
processing (geometry, topology, attributes, analysis), automation can also be used 
for symbology or layout to facilitate map design and publication. 

If your organization publishes printed or online maps, you often would need to 
create many maps with the same template – usually one for each administrative unit 
or region. With the evolution of print composers, GIS software offer more and more 
layout features, notably for the creation of atlases enabling the compilation of 
ordered maps and information in the template. Unlike isolated maps, the atlas 
provides readers with a more in-depth representation of the spaces and themes 
addressed by combining maps at different scales and graphic or text elements. 

The automation of maps and indicators in the form of standardized templates 
allows both time saving for the production of maps but also a greater graphical 
consistency of the maps by the homogenization of the layout. This dimension is 
particularly interesting for the setting up of a graphic charter in the publishing of 
cartographic documents. This chapter proposes to explore several methods and tools 
to produce new indicators and to implement a homogeneous, original and stylized 
cartographic atlas with the QGIS software. 

                        
Chapter written by Boris MERICSKAY. 
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1.2. Automation of maps and indicators 

The objective of this chapter is to automate with QGIS the production of an atlas, 
combining maps and indicators, of the Corsica local region. By using different 
datasets at the municipal level (population census, agricultural census) and by using 
several spatial analysis tools, the idea is to initially calculate several key indicators 
aiming at characterizing these new territories. The combination of different maps 
and key figures provides the reader with additional complementary elements 
(statistics and maps).  

 

Figure 1.1. Atlas of Corsica local regions. For a color version of  
the figure, see www.iste.co.uk/baghdadi/qgis3.zip 

The implementation of this atlas is based on automated map production 
combined with several indicator-creation processes. Figure 1.1 illustrates the 
processing steps for atlas implementation in QGIS. To facilitate its reading, 
processing and handlings are grouped into five main stages, from the 
conceptualization to the publication of the atlas: 

1) atlas template designing; 

2) data preparation and indicators creation; 

3) atlas implementation in QGIS environment; 

4) atlas implementation in the print composer; 

5) atlas publication. 
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Figure 1.2. Workflow for calculating indicators  

 

Figure 1.3. Handling flow for atlas implementation 

3, 4 and 5 
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1.2.1. Step 1: atlas template designing 

The first step is to design the atlas template (items and layout). The items depend 
on the objective of the atlas (communication, decision-making and analysis).  

We propose in this chapter an atlas template to present the local regions of 
Corsica based on seven items as illustrated in Figure 1.4: 

1) main map (municipalities, main roads, protected areas, forests); 

2) municipal population density map; 

3) intermunicipal cooperations map; 

4) overview map; 

5) name of local region; 

6) logo; 

7) indicators. 

 

Figure 1.4. Atlas template 

1.2.2. Step 2: data preparation and indicators creation 

The second step is to prepare the datasets (reproject, transformation) and create 
indicators for the map atlas. The objective of this step is to enrich the atlas coverage 
layer of basic and derived statistics (number of communes, population, forest area, 
number of farms, etc.) to create indicators.  
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Datasets use different coordinate reference systems (CRS) – WGS 84 and 

Lambert 93. To facilitate processing it is necessary to harmonize the CRS of spatial 
datasets using the Lambert 93 projection as the reference coordinate reference 
system for all layers of the project.  

QGIS functionalities: 
- Reproject layer: QGIS geoalgorithms > Vector general tools 

1.2.2.1. Calculate basic statistics  

Municipalities layer: Calculate the municipal population density. 

 
Forests layer: Calculate the area of forests. 

 
QGIS functionalities: 
- Field Calculator  

1.2.2.2. Aggregating municipal data at the scale of local regions 

The second step of data preparation is to change the analysis scale by 
aggregating municipal data at the local regional scale. In order to carry out this 
transformation of the data, it is necessary to mobilize the spatial join1, which makes 
it possible to associate and aggregate attributes from one layer to another according 
to topological relationships between objects in space (intersect, within, contains).  
A spatial join involves matching rows from the Join Features to the Target Features 
based on their relative spatial locations. 

To spatially join the attributes of the common layer to that of the project 
territories, it is  important to be vigilant about the topology of the objects. Indeed the 
topological consistency that defines the quality of the join is not always good. As 
illustrated in Figure 1.5, the topological coherence of the boundaries of 
municipalities and project boundaries is not of good geomatric quality.  

                        
1 Joins attributes from one feature to another based on the spatial relationship. The target 
features and the joined attributes from the join features are written to the output feature class. 
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Figure 1.5. Example of topological errors between the boundaries  
of municipalities and local regions 

This current situation can be solved by transforming the geometry of one of the 
layers and more precisely by using the polygonal centroids to facilitate spatial 
joining (Figure 1.6). 

 

Figure 1.6. Polygons spatial join based on centroids. For a color version  
of the figure, see www.iste.co.uk/baghdadi/qgis3.zip 

We must also be vigilant about the geometric transformation of polygons in 
points. As shown in Figure 1.7, the centroid of the municipality of Saint-Florent is 
located outside the perimeters of local areas. It is therefore necessary to replace the 
centroid within the boundaries of the project territories in order not to compromise 
the spatial junction. 
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Figure 1.7. Example of topological error following the transformation  

QGIS functionalities: 
- Polygon centroids: QGIS geoalgorithms > Vector geometry tools OR SAGA > Vector 
polygon tools 
- Move feature: Digitizing toolbar  

Aggregating municipal population at the scale of local regions 

 

Aggregating forest areas at the scale of local regions 

 
Aggregating agricultural census data at the scale of local regions 
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Once the various spatial joins have been realized, the area of the project 
territories must be calculated. The atlas coverage layer (Final Local regions) now 
contains a series of new fields that will be mobilized thereafter. To facilitate the 
creation of the atlas and in particular the dynamic display of the created indicators, it 
is advisable to clean the attribute table of the Final Local regions layer by deleting 
the unnecessary fields and renaming the fields that will be mobilized (Figure 1.8) 

 

Figure 1.8. Attribute table of Final Local regions layer after attribute table cleaning 

QGIS functionalities: 
- Spatial Join: QGIS geoalgorithms > Vector general tools > Join attributes by location 
- Attribute table cleaning: Fields calculator > Erase field 

1.2.3. Step 3: atlas implementation in QGIS project 

Once the data have been prepared, it is time to move on to formatting. The idea 
is to provide here a series of tips to optimize the formatting of the data in order to 
produce aesthetically pleasing, comprehensible and original maps that will be 
integrated into the atlas boards (atlas coverage layer, rule-based display, masks, 
custom labels). 

1.2.3.1. Configure atlas coverage layer 

The first step is to configure the atlas coverage layer (Figure 1.9). It is on the 
objects of this layer that the atlas will be based for map automation. To define this 
parameter, it is necessary to apply to the coverage layer a rule-based style by 
mobilizing the filter @atlas_featureid = $ id.  

It is also possible to mobilize a symbology of the Inverted Polygons type so that 
the emphasis at the graphic level is put on the selected project territory. They need to 
be rule based (style) and need to contain the following rules (in Style): 
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Figure 1.9. Principle of atlas coverage layer. For a color version of the  
figure, see www.iste.co.uk/baghdadi/qgis3.zip 

QGIS functionalities: 
- Rule-based style: Layer properties > Style > Rule 
- Inverted polygons style: Layer properties > Style > Inverted polygons 

1.2.3.2. Designing the main map 

The main map represents the local regions by combining reference data and 
environmental data relating to protection: 

–  local regions; 

– municipalities with labels (names); 

– main roads; 

– forests; 

– protected environmental areas (ZNIEFF);  

– basemap. 

The idea here is to combine several modes of representation of the data in order 
to obtain aesthetically pleasing, clear and customizable maps that will be generated 
in an automated way (atlas filter, inverted polygon and label mask).  

The choice of the basemap is an important step for map design. With Web 
services as WMS (Web Map Service), it is possible to integrate a diverse selection 
of basemaps into QGIS. In addition to the classical basemaps like streets or imagery, 
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it is now possible to mobilize more minimalist or customized basemaps for use as 
adapted basemaps. The best service to personalize and use original basemaps in 
QGIS is Mapbox (https://www.mapbox.com). Mapbox allows the user to quickly 
create their own basemap using data from OpenStreetMap and display it in QGIS 
using a WMTS.  

After configuring the layout of the layers, the basemap and the display of labels, 
the Mask extension must then be used to display with a mask only the labels of the 
municipalities of the local region selected. 

 

Figure 1.10. Example of layout of main map. For a color version of the figure, 
 see www.iste.co.uk/baghdadi/qgis3.zip 

QGIS functions: 
- Symbology: Layer properties > Style 
- OpenLayers Plugin or QuickMaps Services to add basemaps from Internet 
- Mask Extension to display only certain labels 
- Inverted Polygons: Layer properties > Style 
- Original basemap: WM(T)S connection 
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1.2.3.3. Municipal population density map 

The objective is here to design a map to present the population density of the 
municipalities (Figure 1.11). It is necessary to duplicate the layer in the layer 
manager in order to apply a symbology in plots of colors to represent the values.  

The classification step is particularly important and requires real work and 
reflection on the part of the map designer. Indeed, the different automated methods 
of discretization proposed in GIS software must be used with caution, since they are 
rarely relevant.  

A good classification concerns both the choice of the number of classes and the 
selection of a data classification method. The reflection and labor of the cartographer 
must mobilize the histogram of the values and the basic statistics of the statistical 
series to be generalized (mean, standard deviation, minimum and maximum). As is 
often the case, the map maker uses a type of data classification to produce their own 
unique choropleth map. Each data classification method impacts the reader 
differently. 

 

Figure 1.11. Example of municipal population density map. For a color  
version of the figure, see www.iste.co.uk/baghdadi/qgis3.zip 

QGIS functionalities: 
- Symbology: Layer properties > Style > Graduated 
- Classification: Histogram of Distribution, Statist (extension), Basic statistics for 
numeric fields 
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1.2.3.4. Intermunicipal cooperations map 

The objective is to produce here a map representing the various Corsican 
Intermunicipal cooperations (Figure 1.12). In addition to applying a categorizated 
symbology, it is also necessary to configure the label display of the Intermunicipal 
cooperations names (update the Mask extension to apply a label mask on the 
Intermunicipal cooperation layer). To complete the map, it is necessary to duplicate 
the Intermunicipal cooperation layer to apply a suitable formatting (blank contours 
without filling for example). 

 

Figure 1.12. Example of an Intermunicipal cooperation map in Corsica.  
For a color version of the figure, see www.iste.co.uk/baghdadi/qgis3.zip 

QGIS functions: 
- Symbology tool: Layer properties 
- Mask extension to display only labels of the selected project territory 

1.2.3.5. Overview map 

The objective here is to produce an overview map which will allow us to locate 
the project territory of the atlas plate at the level of Corsica. It is necessary to 
duplicate the layer of the project territories and to apply to it a simple symbology.  
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1.2.4. Step 4: atlas implementation in print composer 

1.2.4.1. Configuration and implementation of atlas 

The first step to implement an atlas in print composer is to configure and 
generate the atlas. To do this, you must activate the atlas functions, define the 
coverage layer and configure the main map (dimension, position, frame, scale, 
legend, arrow, sources). Once the map is implemented, you must lock the layer and 
its style in the properties of the map (Figure 1.13). 

 

Figure 1.13. Add main map to the atlas template. For a color version of  
the figure, see www.iste.co.uk/baghdadi/qgis3.zip 

1.2.4.2. Add dynamic items (title, indicators) 

In this step, it is necessary to add to the pages of the atlas a series of dynamic 
items, which will update according to the pages of the atlas: 

– title (based on the field “pays” of the local region layer); 
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– indicators (based on the fields computed and aggregated upstream) with the 
mobilization of pictograms for an infographic-type rendering. 

 

Figure 1.14. Add title and indicators to the atlas template. For a color version  
of the figure, see www.iste.co.uk/baghdadi/qgis3.zip 

1.2.4.3. Add static items 

The idea here is to enrich the pages of the atlas with static items (such as logo or 
pictos) that will always be similar regardless of the pages of the atlas. 

1.2.4.4. Add municipal population density 

The aim here is to activate a symbology for the municipal population density 
map in the QGIS project. Then add the map legend, scale and source. It is also 
necessary to configure the parameters controlled by the atlas. Once the map is 
implemented, it should lock the layer and its style in the properties of the map. 
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Figure 1.15. Add municipal population density map to the atlas template.  
For a color version of the figure, see www.iste.co.uk/baghdadi/qgis3.zip 

1.2.4.5. Add intermunicipal cooperation map 

As before, the aim here is to activate the symbology of the Intermunicipal 
cooperation layers in the QGIS project. Next, configure the map in print composer 
and add the scale and source. Once the map is implemented, it should lock the layer 
and its style in the properties of the map. 

 

Figure 1.16. Add Intermunicipal cooperation map to the atlas template. For a color 
version of the figure, see www.iste.co.uk/baghdadi/qgis3.zip 
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1.2.4.6. Add overview map 

First, activate the Local regions layers in the QGIS project and apply a basic 
symbology. Add the map to the composer and configure it as a preview map. Once 
the map is formatted, it is advisable to lock the layer and its style in the properties of 
the map. 

 

Figure 1.17. Example of completed atlas template. For a color version of the figure, 
see www.iste.co.uk/baghdadi/qgis3.zip 

1.2.5. Step 5: atlas publication 

Once the different structuring elements of the template are configured, it is time 
to publish the atlas (as image, svg or pdf) by launching map automation. The Atlas 
tool will iterate through each feature in the coverage layer and create a separate map 
image based on the template we created. You can see the images in the directory 
once the process completes. 
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Figure 1.18. Overview of the pages of the atlas. For a color version of  
the figure, see www.iste.co.uk/baghdadi/qgis3.zip 

1.3. Implementation of the application 

1.3.1. Software and data 

1.3.1.1. Software required 

The process discussed in this chapter uses the basic functionality of the QGIS 
software (version 2.18). It is also necessary to install some additional extensions to 
carry out the processing chain: GroupStats, Mask, OpenLayerPlugin, Statist. 

 
Figure 1.19. QGIS extensions 
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1.3.1.2. Data 

This chapter is based on eight open data datasets from different organizations 
(Corsica region, National Geographic Institute, OpenStreetMap). 

Name layer Source Year CRS 
Municipalities IGN  2016 2154 

Intermunicipal cooperations OSM 2016 4326 

Local regions  Opendata Corsica 2017 4326 

Main roads IGN 2017 2154 

Agricultural census Opendata Corsica  2010 4326 

ZNIEFF type 1 INPN 2016 2154 

ZNIEFF type 2 INPN 2016 2154 

Forest Opendata Corsica  2017 4326 

Table 1.1. Summary of the data used 

Here are some links for downloading referential data: 

1) Municipalities 
Name of layer: GEOFLA® 2016 v2.2 Communes France Métropolitaine 
URL: http://professionnels.ign.fr/geofla  

2) Intermunicipal cooperation 
Name of layer: Contours des EPCI 2015 (simplifié à 100 m) 
URL: https://www.data.gouv.fr/fr/datasets/contours-des-epci-2015  

3) Local regions 
Name of layer: Territoires de projet de la Collectivité Territoriale de Corse 
URL: https://www.data.corsica/explore/dataset/territoires-de-projet-de-la-

collectivite-territoriale-de-corse/export   

4) Main roads 
Name of layer: ROUTE 120®   
URL: http://professionnels.ign.fr/route120  
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And here are the links for downloading thematic data: 

5) Agricultural census 
Name of layer: Recensements Agricoles par communes (1988, 2000 and 2010) 
URL: https://www.data.corsica/explore/dataset/recensementagricole/export  

6) ZNIEFF from type 1 
Name of layer : Zones Naturelles d’Intérêt Ecologique Faunistique et Floristique 

de type 1 
URL : https://inpn.mnhn.fr/telechargement/cartes-et-information-

geographique/inv/znieff1  

7) ZNIEFF from type 2 
Name of layer: Zones Naturelles d’Intérêt Ecologique Faunistique et Floristique 

de type  
URL: https://inpn.mnhn.fr/telechargement/cartes-et-information-

geographique/inv/znieff2   

8) Forests 
Name of layer: Forêts de Corse 
URL: https://www.data.corsica/explore/dataset/forets-de-corse/export  

1.3.2. Step 2: data preparation and indicators creation 

1.3.2.1. Calculate municipal population density  

Process Handling in QGIS 

1. Select Corsica 
municipalities 

In QGIS: 

• Open Attributes table 
In Select by expression: 

• Write the query: "NOM_REG"  =  'CORSE' 
In the Attributes table: 

• Invert the selection 
• Switch to Editing mode 
• Delete selected features 
• Stop Editing mode and save 
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2. Calculate 
municipal population 
density 

In Field calculator: 

• Create new Field “AREA” (decimal type) > Calculate 
area of municipalities with function $area by writing 
the query “$Area/1000000” (convert m2 to km2) 

 
In Field calculator: 

• Create new field “Density” (integer type) > Calculate 
municipalities population density by writing the query 
“Population/AREA” 

Table 1.2. Steps for the calculation of population density in the layer “Municipalities” 

1.3.2.2. Calculate forest area 

Process Handling in QGIS 

1. Calculate Forest 
Area 

In Field calculator: 

• Create new Field “AREA” (decimal type) > Calculate 
Forest Area with the expression $Area/1000000 
(convert m2 to km2) 

 

Table 1.3. Step for the calculation of forest area 

1.3.2.3. Aggregate municipal data at scale of local regions 

1.3.2.3.1. Aggregate data from municipalities layer at scale of local regions 
(population and number of municipalities) 

Process Handling in QGIS 

1. Create polygon 
centroids 

In QGIS: 

• Vector > Geometry tools > Polygon centroids 
• To facilitate spatial joining, it is recommended to create a 

new field (integer type) with the value of the column 
POPULATION > Field Calculator 

2. Reproject local 
region layer 

• Save vector layer with CRS 2154 (Lambert 93) 
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3. Aggregate 
municipal data at 
scale of local 
regions 

• Vector > Data Management Tools > Join attributes by 
location  

 

 
 
It is essential to verify if the spatial join has performed well at the 
aggregation level: 

• Use a statistical tool to compare the fields of the joined 
layer and the new fields resulting from the aggregation 
(Basic statistics for numeric fields or Statist extension)  
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Table 1.4. Steps for aggregating population data 

1.3.2.3.2. Aggregate forest area at the scale of local region 

Process Handling in QGIS 

1. Reproject forest 
layer  
 

In QGIS: 

• Save vector layer with CRS 2154 (Lambert 93) 

2. Create polygon 
centroids 

• Vector > Geometry tools > Polygon centroids 

3. Aggregate data at 
scale of local 
regions 

• Vector > Data Management Tools > Join attributes by 
location  

 
Other available tool: 
 

• Extension MMQGIS > Combine > Spatial Join 
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Table 1.5. Steps for aggregating forest data 

1.3.2.3.3. Aggregate data of the layer agricultural census 
(livestock/area/number of exploitations) 

Process Handling in QGIS 

1. Keep only the 
2010 Agricultural 
census data 
 

In QGIS: 

• Open Attributes table 
In the attribute selector :  

• Write the query: “annee”  =  ‘2010’  
In the Attributes table: 

• Invert selection 
• Switch to Editing mode 
• Delete selected features 
• Stop Editing mode and save 

 
2. Reproject 
Agricultural census 
layer 

• Save vector layer with CRS 2154 (Lambert 93) 

3. Aggregate data 
at scale of local 
regions 

• Vector > Data Management Tools > Join attributes by 
location  
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• Check results of the spatial join 

   
 

Table 1.6. Steps for aggregating agricultural census data 

 



Design and Implementation of Automated Atlas     25 

 
1.3.2.3.4. Calculate area of local region and clean attribute table 

1. Calculate area of 
local region 

In Field calculator: 

• Create new Field “AREA”  (decimal type) > Calculate 
area of municipalities with function $area by writing the 
query $Area/1000000 (convert m2 to km2) 
 

2. Clean Attribute 
table 

In the Attribute table: 

• Switch to Editing mode 

• Delete unnecessary fields   

• Rename fields with field calculator  

Table 1.7. Calculate area of local region and clean attribute table 

1.3.2.4. Prepare intermunicipal cooperations layer 

Process Handling in QGIS 

1. Reproject 
intermunicipal 
cooperations layer 

In QGIS: 

• Save vector layer with CRS 2154 (Lambert 93) 
2. Keep only the 
intermunicipal 
cooperations of 
Corsica 

In QGIS: 

• Vector > Research tools > Select by location 
• Select intermunicipal cooperations layer that intersects 

with the municipalities of Corsica 

In the Attributes table: 

• Invert selection 
• Switch to Editing mode 
• Delete selected features 
• Stop Editing mode and save 

Table 1.8. Steps for the preparation of the intermunicipal cooperations layer 

1.3.3. Step 3: atlas implementation in QGIS project 

This step consists in shaping the different layers of data that will be mobilized in 
the various maps of the atlas. The other dimensions of this step revolve around the 
definition of the style of the coverage layer (on which the atlas is based) and the 
configuration of the display masks for the labels. 
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1.3.3.1. Defining the coverage layer of the atlas 

Process Handling in QGIS 

1. Defining the 
coverage layer of 
the atlas 

In the style properties of the coverage layer:
 

• Choose a style based on a set of rules 

 
• Click on the Rule for edit rule  
• Click on filter to edit the filter 

 
• Enter the expression: @atlas_featureid =  $id   

 
2. Apply  
Inverted polygons 
style 

In the style properties of the coverage layer:  
• Select Inverted polygons 

 

 
 

• Configure: 

o white fill  
o 20% of transparency 
o black outline, width of 1 
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Table 1.9. Steps for defining the coverage layer of the atlas 

1.3.3.2. Configuration of municipalities labels mask 

Process Handling in QGIS 

1. Apply a 
symbology 

In QGIS: 

• Format the data 
• Configure labels of municipalities 

2. Apply a mask to 
display only the 
municipalities labels 
of selected feature 

In QGIS: 

• Select a feature of the local region layer  
• Run the Mask extension 
• Configure the Mask Extension 
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Table 1.10. Steps for the configuration of municipalities labels mask 

1.3.3.3. Configuration of mask of intermunicipal cooperations labels 

Process Handling in QGIS 

1. Apply a mask to 
display only the 
intermunicipal 
cooperations labels of 
the selected local 
region 

In QGIS: 

• Select a feature of the local regions layer  
• Update the current mask 
• Configure the Mask Extension 
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Table 1.11. Steps for the configuration of intermunicipal cooperations labels mask 

1.3.4. Step 4: atlas implementation in print composer 

This fourth step has as its objective the configuration and the implementation of 
the atlas in the composer. 

1.3.4.1. Activation of atlas in print composer 

Process Handling in QGIS 

1. Define map 
symbology 

In QGIS:

• Activate layers of main map 

2. Configuration of 
coverage layer 

In the composer: 

• Add map 
• Activate and configure atlas properties  

o Click on the Atlas generation tab 
o Click on Generate an atlas 
o Select the Coverage layer 
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3. Configuration of 
map 

In the Item properties tab: 

• Activate the function Controlled by atlas 
• Configure Margin around feature 
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4. Generate atlas in 
print composer 

In the composer toolbox:  

• Click on Preview atlas 
• Use the arrows to view the different maps generated 

automatically: 

 
 

5. Lock layer and 
style layer 

In the Item properties tab:  

• Lock layers 
• Lock styles for layers 

 
 

6. Finalize the main 
map 

In print composer: 
 

• Add map items: Arrow, scalebar, source, legend 
 

Table 1.12. Steps for the activation of atlas in print composer 

1.3.4.2. Add dynamic items 

At this stage, it is necessary to configure the dynamic elements that will be 
displayed in the atlas maps according to the local regions (project name and 
indicators). 
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Process Handling in QGIS 

1. Add Title  In print composer:

• Add new label for the title of template (name of  
local region) 

In Item properties: 

• Click on Insert an expression 

In window: 

• Indicate the name of the field where we will find the 
information of the names of local regions 

 
• Configure Appearance of the title (Font, font color, size, 

alignment) 

2. Add indicators In print composer:

• Add new label for indicators 

In Item properties: 

• Click on Insert an expression 

In window: 

• Indicate the name of the field where we will find the 
information of the names of local regions 

In the main properties of the indicator label: 

• Indicate, after the expression, the unit of the indicator 
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Change the appearance (size, font,…) 
 

3. Add icons 
 To give an infographic style to the indicators you  

can add icons after each indicator 
(http://www.flaticon.com): 

 
In print composer: 
 

• Add image  
 

• Define the location of the image (use the SVG format for 
better rendering) 
 

 
 

Table 1.13. Steps for adding dynamic items 
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1.3.4.3. Add municipal population density map 

Process Handling in QGIS 

1. Define map 
symbology  

In QGIS: 

• Activate municipalities V2 layer 
• Use a good symbology (graduated style) for representing 

these data 

2. Add map in 
print composer 

In print composer:

• Click Add Map  
• Define map position, scale and dimensions 

3. Configuration 
of map 

In Item properties tab:

• Activate the function Controlled by atlas 
• Configure Margin around feature 

 

 
 

4. Lock layers 
and style layers 
of the maps 
 

In Item properties tab: 

• Lock layers 
• Lock styles for layers 
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Table 1.14. Steps to configure municipal population density map 

1.3.4.4. Add Intermunicipal cooperations map 

Process Handling in QGIS 

1. Define map 
symbology 

In QGIS: 

• Activate Intermunicipal cooperation layer 
• Use a good symbology (Categorized style) for representing 

these data 

2. Add map in 
print composer 

In print composer:

• Click Add Map  
• Define map position, dimensions and scale 

3. Configuration 
of map 

In Item properties tab:

• Activate the function Controlled by atlas 
• Configure Margin around feature 

4. Lock layers and 
style layers of the 
maps 
 

In Item properties tab: 

• Lock layers 
• Lock styles for layers 

Table 1.15. Steps to configure intermunicipal cooperations map 
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1.3.4.5. Add overview map 

Process Handling in QGIS 

1. Define map 
symbology 

In QGIS: 

• Activate final local region layer 
• Use a basic symbology (Categorized style) for representing 

these data 
 

2. Add map in 
print composer 

In print composer:

• Click Add Map  
• Define map position and dimensions 

3. Configure 
overview 
parameters of the 
map 

In Item properties:
 

• Add an Overview 
• Configure this overview with a map frame of Map 0 (the 

main map) 
• Lock layers 
• Lock styles for layers 

 

 
 

Table 1.16. Steps to configure the overview map 
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1.3.5. Step 5: atlas publication 

The different elements of the atlas are configured (maps, indicators, title, etc.). In 
this last step, the production of the atlas boards is carried out by exporting them as 
images. 

Process Handling in QGIS 

1. Customize 
output filename 
with expression 

In the Atlas generation tab:

• Configure the output filename by assigning the value of the 
field “pays” (name of local regions) 
 

 
 

 
 
NB : If the field “pays” as the name of files generated by the atlas 
causes an error under GNU / Linux, then either change the values that 
caused the problem in the layer or change the output file name by 
putting the expression as the following: ("pays", "/", "-") 
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2. Run export In print composer:

• Click on Export Atlas as Images 
 

 
 
 

• Create a folder in which the pages (images) of the atlas 
will be stored 

• Select this directory and choose 
3. Configure 
image export 
options 

Choose the export resolution according to the end use of the atlas 
 

 
 

Web publication 100dpi; PDF Publication 300dpi; Printing minimum 
400dpi. 

• Click on Save 
• Check the export 

Table 1.17. Steps for the publication of the atlas 




